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事前準備
• チュートリアル当日までに以下の準備をお願いします


• 仮想化ソフト VitualBox のノートPCへのインストール


• https://www.virtualbox.org/wiki/Downloads にアクセスし、ご使用の OS 
(Windows, Mac OSなど)に応じたファイルをダウンロードし、インストール


• Windows 10 はまだ正式サポートされていません。ご注意ください


• 可視化ソフト VMD のユーザ登録


• http://www.ks.uiuc.edu/Development/Download/download.cgi?PackageName=VMD に
アクセス、バージョン 1.9.2 の Source Code をクリック


• 好みのユーザ名とパスワード(普段お使いのパスワードとは異なるものを使っ
てください)を入力し、「Continue with registration …」をクリック


• フォームに氏名や電子メール等を入力し、「Register …」


• 自動的にファイルのダウンロードが始まりますが、中断してかまいません
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https://www.virtualbox.org/wiki/Downloads
http://www.ks.uiuc.edu/Development/Download/download.cgi?PackageName=VMD


• MateriApps カタログ 


• ALPS解説記事 


• 講習会資料 (このスライドのコピー)


• MateriApps LIVE! USB


• README.html, github.css


• VirtualBox インストーラ: VirtualBox-*-OSX.dmg, VirtualBox-*-Win.exe


• VirtualBox 設定スクリプト: vbconfig.*


• MateriApps LIVE! VitualBox 仮想ディスクイメージ: MateriAppsLive-*.ova


• VMD バイナリアーカイブ: vmd-*.tar.gz


• 講習会資料: materiappslive-20150902.pdf


• ALPS 解説記事: alps-2015.pdf

配布物
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本日のメニュー
• MateriApps LIVE! の起動方法の説明

• 分子動力学法による溶液のシミュレーション


• 汎用分子動力学ソフト Gromacs (+ MODYLAS の紹介)

• 可視化ツール VMD


• モンテカルロ法によるスピン模型の相転移シミュレーション

• 強相関格子模型のシミュレーションパッケージ ALPS

• 可視化ツール ParaView


• 第一原理計算手法によるバンド計算 (本日は行いません)

• 第一原理計算ソフト OpenMX

• 入力補助 C-Tools、可視化 VESTA、フェルミ面 XCrysDen


• 量子化学計算 (準備中)

• 目標


• 普段、数値計算に縁がない人にも、「私にもできそう」と思ってもらうこと

• 学部生の授業に使えるレベルにまでもっていくこと
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MateriApps LIVE! とは？
• USBメモリから直接ブートできる Linux システム (Debian Live Linux)


• Windows、Mac などで利用可


• インストール作業なしで物質科学アプリを実行できる


• バージョン1.8公開 (2015年8月31日)


• MateriAppsで紹介している公開アプリ・ツールを収録


• 2015年8月現在：ABINIT, AkaiKKR, ALPS,                                                           
CP2K, Feram ,ERmod, Gromacs, OpenMX、                                               
Quantum Espresso, SMASH, xTAPP, VESTA 等


• GAMESS, VMDには自動インストーラーを準備


• MateriApps LIVE! サイトからダウンロード可能
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まずははじめてみましょう
✓ VMD のユーザ登録


• http://www.ks.uiuc.edu/Development/Download/download.cgi?PackageName=VMD から
ユーザ名とパスワードを登録してください


✓ USB メモリのファイルをハードディスクにコピー


• すべてのファイルをパソコン(デスクトップ等)にコピーしてください


• MateriApps LIVE! の起動方法は2種類あります


1. 仮想化ソフト VirtualBox 上で起動する (本日はこちらを説明)


• お手軽、簡単、確実。ただしメモリが少ない環境では動作が重くなる


2. USB メモリを差し込んで再起動する


• 計算は速いが PC によってはうまく起動しない。ネットの設定が少し面倒

MateriApps, 2013-2015. All rights reserved.6
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VirtualBox からの起動方法
✓ インストーラをダブルクリックして VirtualBox をインストール


• Windows版: VirutalBox-5.0.2-102096-Win.exe


• Mac版: VirtualBox-5.0.2-102096-OSX.dmg


• 途中の質問には適当に答える


✓ MateriApps LIVE! のインポート


• MateriAppsLive-1.8-x86_64.ova をダブルクリック


• VirtualBox が起動してインポート画面が開くので、「インポート」ボタンを押す


• 2～3分かかるが完了するとマネージャーが起動


• ホスト (ホストOS) : もともと動いている OS (Windows、Mac OS X など)のこと


• 仮想マシン (ゲストOS) : VirtualBox の中で動いている OS (= MateriApps LIVE!)

MateriApps, 2013-2015. All rights reserved.7



VirtualBox の設定
✓ 設定: 不要なポップアップメッセージを非表示にする


• Windows: USBメモリからコピーした vbconfig.bat をダブルクリック

• Mac OS X: vbconfig.command をダブルクリック 
あるいはターミナルで「sh vbconfig.sh」を実行


✓ 設定: ホストOSのディスクに仮想マシンからアクセスできるように

1. 	VirtualBox マネージャー画面で MateriAppsLive-1.8 を選択し「設定」

2. 	「共有フォルダー」タブを開き、右側の「+」(新規共有フォルダーを追加し
ます)をクリック


3. 	「フォルダーのパス」の右側の「ｖ」マークをクリックし、「その他」を選
択。さきほどUSBメモリからコピーしたフォルダーを選択する


4. 	「自動マウント」をチェックし「OK」⇒ さらに「OK」

5. 	仮想マシンを起動すると、3で選択したフォルダが、/media/sf_... の下に見
える

MateriApps, 2013-2015. All rights reserved.8



VirtualBox からの起動
1. 「MateriAppsLive…」を選択


2. 起動ボタンを押す


3. ログイン画面がでるまでその
まま待つ

MateriApps, 2013-2015. All rights reserved.9

まれに古いパソコンで起動しない場合がある。そのときは
MateriAppsLive-1.8-i386.ova (32bit版)を試してみる



MateriApps LIVE! へのログイン
• しばらするとログイン画面が表示される


• 下記の情報を使ってログイン


• ユーザ名(login): user


• パスワード(password): live


• 右の画面が出れば成功


• 重要なボタン


• スタートメニュー


• 終了

MateriApps, 2013-2015. All rights reserved.10



日本語キーボード、コピー&ペースト
• 日本語キーボード(「＠」が「P」の右にあるタイプ)では、記号が正しく入力でき
ません。その場合、以下の設定を行ってください


• 「スタートメニュー」⇒「Accessories」⇒「LXTerminal」


• ターミナル(端末)が立ち上がるので「setxkbmap -layout jp」と入力しリターン


• 「＠」が正しく入力できることを確認


• (英語配列に戻したいとき: 「setxkbmap -layout us」)


• ホストOSでPDFファイルからコピーした文字列を、仮想マシンの端末でペースト
する方法


• 端末上で右クリック ⇒「Paste」


•  あるいは、「shift」と「control」を同時に押しながら「V」


• 文字列のコピーは、右クリック ⇒「Copy」あるいは「shift + control + C」

MateriApps, 2013-2015. All rights reserved.11



VMDのインストール
• スタートメニュー ⇒「MateriApps」⇒「VMD Setup」


• 方法1: ソースコードをダウンロード & インストール (要ネット接続)


1. 「Download source tarball from official website」をチェック


2. 登録ユーザ名、パスワードを入力 ⇒「Install」


• 方法2: ハードディスクに保存してあるアーカイブからインストール (本日はこちら)


1. 「Use a source tarball on local storage」をチェック


2. ファイル選択画面で左の「File System」を選択 ⇒ 「media」⇒「sf_…」


3. 「vmd-1.9.2.bin.LINUXAMD64.opengl.tar.gz」を選択 ⇒「Install」 

(32ビット版(MateriAppsLive-1.8-i386.ova)をインポートした場合は、かわり

に「vmd-1.9.2.bin.LINUX.opengl.tar.gz」を選択する)

MateriApps, 2013-2015. All rights reserved.12



分子動力学法による溶液のシミュレーション
• 分子動力学法とは


• 適当な力場セットのもとで分子位置の時間発展を計算する


• 温度一定、圧力一定など、現実的な条件設定が可能


• 得られる物理量: エネルギー、自由エネルギー、溶解現象(溶解に関する各種エネ
ルギー)、各種分布関数


• 分子動力学法の代表的なアプリ


• NAMD、LAMMPS、Gromacs : 海外のオープンソースアプリ


• Modylas : 特に高並列計算機に特化した国産アプリケーション


• VMD : タンパク質、核酸、脂質二重層などの生体系のモデリング、可視化、解析
のためのソフトウェア

MateriApps, 2013-2015. All rights reserved.13



可視化ソフト VMD の起動
• 端末からの起動


• 「スタートメニュー」⇒「Accessories」⇒「LXTerminal」


• 端末で「vmd」と入力しリターン


• 別の起動方法: 「スタートメニュー」⇒「VMD Setup」⇒「start VMD」


• メインウィンドウ(VMD Main)と、OpenGLウィンドウ(黒)の2つが開く


• OpenGLウインドウが画面からはみ出してしまっている場合は、option キーを押
しながらドラッグ(Mac)、あるいは ALT キーを押しながらドラッグ(Win)


• VMD では、PDB からタンパク質の構造データを自動ダウンロード可能


• 「File」⇒「New Molecule…」


• ファイル名の欄に PDB の4文字コード(例: 4AKI)を入力 ⇒「Load」

MateriApps, 2013-2015. All rights reserved.14



まずは水分子のシミュレーション
• ターミナルを開く (以下、Italic 文字はターミナルへの入力を表す)


• スタートメニュー ⇒「Accessories」⇒「LXTerminal」


• チュートリアルファイルのコピー


•  cd

•  cp -r /usr/share/gromacs/tutor/water  .

•  cd water


• 使用するファイル


• spc216.pdb : 水の構造情報


• grompp.mdp : シミュレーションパラメタ


• spc216.pdb の中身を見てみる


•  vmd spc216.pdb

• 「Graphics」⇒「Presentations…」⇒「Drawing Method」を変更してみる

MateriApps, 2013-2015. All rights reserved.15



水のシミュレーション
• 少し大きめの箱を作る (4nm x 4nm x 4nm)


•  editconf -f spc216.pdb -o water.gro -box 4


• 水を詰める


•  genbox -cp water.gro -cs spc216.gro -o water.gro


• トポロジーファイルの作成 (力場としてOPLS-AA、水のモデルとしてTIP4Pを使う)


•  pdb2gmx -f water.gro -o water.gro -p water.top -ff oplsaa -water tip4p 
• (-ff, -water オプションなしで実行し、「14」「1」と指定しても同じ)


• 実行ファイルの準備


•  grompp -f grompp.mdp -c water.gro -p water.top -o water -maxwarn 5


• MDの実行 (1分ほどかかる)


•  mdrun -v -s water.tpr

MateriApps, 2013-2015. All rights reserved.16



結果の可視化・動画再生
• VMD で可視化 (構造ファイルとトラジェクトリーの読み込み)


• File ⇒ New Molecule… ⇒ Browse… ⇒「confout.gro」を選択 ⇒ Load ⇒ 
Molecule File Browser を閉じる


• VMD Main ウィンドウの「confout.gro」を選択 ⇒ File ⇒ Load Data Into 
Molecule… ⇒ Browse… ⇒「traj.xtc」を選択 ⇒ Load ⇒ Molecule File Browser 
を閉じる

MateriApps, 2013-2015. All rights reserved.17

コマ戻し コマ送り 再生スピード

フレーム移動

先頭へ 最後へ



動径分布関数の作成
• 酸素原子のインデックス(index.ndx)を作成


•  make_ndx -f confout.gro


• 動径分布関数の生成 (rdf.xvg) gnuplot 用)


•  g_rdf -f confout.gro -n index.ndx -xvg none


• gnuplot をつかって動径分布関数をプロット


•  gnuplot -p -e 'plot "rdf.xvg" with line'

MateriApps, 2013-2015. All rights reserved.18

> del 2

Removed group 2 'SOL'

> del 1

Removed group 1 'Water'

> del 0

Removed group 0 'System'

> add OW

Found 2872 atoms with names DD OW

  0 DD_OW               :  2872 atoms

> q



For Copy & Paste

MateriApps, 2013-2015. All rights reserved.19

 cd 
 cp -r /usr/share/gromacs/tutor/water . 
 cd water 
 editconf -f spc216.pdb -o water.gro -box 4 
 genbox -cp water.gro -cs spc216.gro -o water.gro 
 pdb2gmx -f water.gro -o water.gro -p water.top -ff oplsaa -water tip4p 
 grompp -f grompp.mdp -c water.gro -p water.top -o water -maxwarn 5 
 mdrun -v -s water.tpr



水中のペプチドのシミュレーション
• 構造ファイル・トポロジーファイルの準備


•  cd

•  cp -r /usr/share/gromacs/tutor/speptide .

•  cd speptide

•  pdb2gmx -f speptide.pdb -p speptide.top -o speptide.gro -ff gromos43a1 -water spc


• 箱を作って水をつめる

•  editconf -f speptide.gro -o speptide.gro -d 0.5

•  genbox -cp speptide.gro -cs -o speptide_em.gro -p speptide.top


• エネルギー最適化

•  grompp -f em.mdp -c speptide_em.gro -p speptide.top -o speptide_em.tpr 

•  mdrun -v -s speptide_em.tpr -o speptide.top -c speptide_pr.gro

MateriApps, 2013-2015. All rights reserved.20



水中のペプチドのシミュレーション
• 位置の拘束条件を再度見直す 


•  grompp -f pr.mdp -c speptide_pr.gro -p speptide.top -o speptide_pr.tpr 

•  mdrun -v -s speptide_pr.tpr -o speptide.top -c speptide_md.gro


• 分子動力学計算 

•  grompp -f full.mdp -c speptide_md.gro -r speptide.gro -p speptide.top -o speptide_md.tpr 


•  mdrun -v -s speptide_md.tpr -o speptide_out.trr -c speptide_out.gro


• 可視化


• VMD に speptide_out.gro と speptide_out.trr を読み込む


• 実際のシミュレーションでは、、、エネルギー最小化 ⇒ 温度・体積一定で平衡化 
⇒ 温度・圧力一定で平衡化 ⇒ プロダクトラン (grompp ⇒ mdrun の繰り返し)

MateriApps, 2013-2015. All rights reserved.21



For Copy & Paste

MateriApps, 2013-2015. All rights reserved.22

 cd 
 cp -r /usr/share/gromacs/tutor/speptide . 
 cd speptide 
 pdb2gmx -f speptide.pdb -p speptide.top -o speptide.gro -ff gromos43a1 -water spc 
 editconf -f speptide.gro -o speptide.gro -d 0.5 
 genbox -cp speptide.gro -cs -o speptide_em.gro -p speptide.top 
 grompp -f em.mdp -c speptide_em.gro -p speptide.top -o speptide_em.tpr  
 mdrun -v -s speptide_em.tpr -o speptide.top -c speptide_pr.gro 
 grompp -f pr.mdp -c speptide_pr.gro -p speptide.top -o speptide_pr.tpr  
 mdrun -v -s speptide_pr.tpr -o speptide.top -c speptide_md.gro 
 grompp -f full.mdp -c speptide_md.gro -r speptide.gro -p speptide.top -o speptide_md.tpr  

 mdrun -v -s speptide_md.tpr -o speptide_out.trr -c speptide_out.gro



MODYLASの紹介 (CMSIで開発)
• 任意の分子集合体に対する汎用の大規模分子動力学計算プログラム。長距離力の取
り扱いを含め、ナノ分野・バイオ分野における分子動力学計算に必要な各種手法を
備える。高効率の並列計算が可能であり、超並列スパコンを用いて溶媒中のウイル
ス(約1000万原子)の全原子計算やリポソーム(数十万原子)の長時間計算が可能 

MateriApps, 2013-2015. All rights reserved.23
MateriApps,2013-2015. All rights reserved. 

MODYLASの簡単な紹介
任意の分子集合体に対する汎用の大規模分子動力学計算プログラム。長距離
力の取り扱いを含め、ナノ分野・バイオ分野における分子動力学計算に必要
な各種手法を備える。高効率の並列計算が可能であり、超並列スパコンを用
いて溶媒中のウイルス(約1000万原子)の全原子計算やリポソーム(数十万原子)

の長時間計算が可能。



ALPS (Applications and Libraries for Physics Simulations)
• 強相関格子模型シミュレーションのためのライブラリ・アプリケーション群


• 強相関格子模型とは？


• 強相関量子系 (高温超伝導, 重い電子系, 量子磁性, etc) の有効模型


• ハバード模型, ハイゼンベルグ模型, 近藤格子模型, …


• 様々な種類のソルバーを用意


• 厳密対角化, 古典モンテカルロ法, 量子モンテカルロ法,                                           
密度行列くりこみ群(DMRG), 動的平均場近似 (DMFT)


• 対象となる系や興味のある物理量・現象に応じて最適なソルバーを選択できる


• 強相関量子系における多体相関の効果を正確に取り入れたシミュレーション


• 相転移・臨界現象や量子系特有の相(量子液体, 超固体など)の解析に特に有効

MateriApps,2013-2015. All rights reserved.24
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ALPS を利用した研究
• 500 以上の論文で ALPS が利用されている (論文タイトルの例 2014年7月以降)


• Nonequilibrium dynamical cluster theory

• Reliability evaluation of thermophysical properties from first-principles 

calculations

• Phase diagram study of a dimerized spin-S zig–zag ladder

• First order dynamical phase transitions

• Magnetic transitions in the spin-5/2 frustrated magnet BiMn2PO6 and strong 

lattice softening in BiMn2PO6 and BiZn2PO6 below 200 K

• GPU-based simulation of the long-range Potts model via parallel tempering

• Quasi-two-dimensional S=1/2 magnetism of Cu[C6H2(COO)4][C2H5NH3]2

• Exploring unconventional Hubbard models with doubly-modulated lattice gases

• The sign problem in full configuration interaction quantum Monte Carlo: Linear 

and sub-linear representation regimes for the exact wave function 
…

MateriApps,2013-2015. All rights reserved.25

http://alps.comp-phys.org/mediawiki/index.php/PapersTalks

http://alps.comp-phys.org/mediawiki/index.php/PapersTalks


ALPS の機能
• 入出力支援


• 格子構造, 模型は XML を用いて柔軟に指定


• 全てのソルバーに共通した入出力形式


• Python インターフェースを用意


• Python から直接実行、グラフを作成


• 並列化


• パラメータ並列のための並列化スケジューラ


• 量子モンテカルロソルバ (looper)


• 京で20,000ノードまで良好なスケーリング


• 競合するアプリケーション：「なし」?

MateriApps, 2013-2015. All rights reserved.26
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本日のシミュレーション (1)
1. 二次元強磁性イジング模型の相転移シミュレーション


• 相転移を起こす磁性体の最も単純化した模型


• 臨界温度( Tc=2.269… )で連続相転移が起こる


• 高温 (T > Tc): 常磁性相、エントロピーの効果で長距離秩序なし


• 低温 (T < Tc): 強磁性相、相互作用の効果で長距離秩序が現れる


• 臨界点で比熱や帯磁率は発散 (臨界現象)


• 古典モンテカルロ法(メトロポリス法)による平衡状態のシミュレーション


2. イジング模型のスナップショット(スピン状態)の可視化


• 常磁性相、臨界点近傍、強磁性相でのスピン状態を実際に見てみる

MateriApps, 2013-2015. All rights reserved.27
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本日のシミュレーション (2)
3. 二次元XY模型のスピン渦の可視化


• スピンの向きはゆるやかに変化できる。対称性は自発的には破れず長距離秩序
なし。ある温度以下でべき的な準長距離相関 (Kosterlitz-Thouless 転移)


• 低温でスピン渦が対となって出現。高温では渦対が乖離し無秩序相へ


4. 二次元三角格子反強磁性ハイゼンベルグ模型


• 三角格子 ＋ 反強磁性相互作用 = フラストレーション


• スピンは一方向に揃うのではなく互いに違う向きをとる (120度構造)


• 適度な大きさの磁場をかけると、3つの副格子のうち1つが磁場の方向を向く


• 他のスピンは磁場と垂直な方向で渦を作る

MateriApps, 2013-2015. All rights reserved.28
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二次元イジング模型の相転移シミュレーション
• simplemc : 最も基本的な古典モンテカルロ法シミュレーター

• スタートメニュー ⇒「Accessories」⇒「LXTerminal」

• チュートリアルファイルのコピー  (以下、Italic 文字はターミナルへの入力を表す)


•  cd

•  cp -r /usr/share/alps/tutorials/mc-09-snapshot . 
•  cd mc-09-snapshot


• パラメータの変換 (一群のXMLファイル parm9a.*.in.xml の生成)

•  parameter2xml parm9a


• シミュレーションの実行

•  simplemc parm9a.in.xml


• 結果のプロット

•  python plot9a.py

• プロットウインドウ(3枚)を閉じる

MateriApps, 2013-2015. All rights reserved.29



パラメータファイルの中身 (parm9a)

MateriApps, 2013-2015. All rights reserved.30

LATTICE="square lattice"

J=1

ALGORITHM="ising"

SWEEPS=65536

L=8

{ T=5.0 }

{ T=4.5 }

{ T=4.0 }

{ T=3.5 }

{ T=3.0 }

{ T=2.9 }

{ T=2.8 }

{ T=2.7 }

…

正方格子を指定

強磁性相互作用 (J>0)

イジング模型のシミュレータを使う

モンテカルロステップ数

格子の一辺の長さ (L=8, 16, 24)

シミュレーションする温度のリスト


中括弧に入っていないのは共通パラメータ

中括弧ごとにシミュレーションが実行される

(温度毎に XML ファイル(*.task*.*)が作られる)



プロットファイルの中身 (plot9a.py)
• Python スクリプト


• データファイルからの結果の抽出

• システムサイズごとに整理

• matplotlib をつかってプロット

MateriApps, 2013-2015. All rights reserved.31

data = pyalps.loadMeasurements(pyalps.getResultFiles(prefix='parm9a'),

    ['Specific Heat', 'Magnetization Density^2', 'Binder Ratio of Magnetization'])

for item in pyalps.flatten(data):

    item.props['L'] = int(item.props['L'])

magnetization2 = pyalps.collectXY(data, x='T', y='Magnetization Density^2’,

   foreach=['L'])

magnetization2.sort(key=lambda item: item.props['L'])

pyplot.figure()

alpsplot.plot(magnetization2)

pyplot.xlabel('Temperture $T$')

pyplot.ylabel('Magnetization Density Squared $m^2$')

pyplot.legend(loc='best')



より大規模な計算例
• 三次元単純立方格子イジング模型の例


• Tc = 4.512…

• 比熱は臨界点の上下でベキ的に発散、磁化は転移点以下でベキ的に現れる          

(臨界現象)

MateriApps, 2013-2015. All rights reserved.32
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スナップショット(スピン状態)の可視化
• パラメタファイル (parm9b) ⇒


• SNAPSHOT_INTERVAL が追加


• SNAPSHOT_INTERVALごとにスナップ                                                             
ショットが出力される(*.snap)


• シミュレーションの実行


•  parameter2xml parm9b

•  simplemc parm9b.in.xml

•  ls -l parm9b.*.snap


• スナップショットの変換 (*.snap ⇒ *.vtk)


•  snap2vtk parm9b.*.snap

•  ls -l parm9b.*.vtk

• VTK ファイルには格子点の座標とスピン状態(±1)が収められる

MateriApps, 2013-2015. All rights reserved.33

LATTICE="square lattice"

J=1

ALGORITHM="ising"

SWEEPS=16384

THERMALIZATION=0

SNAPSHOT_INTERVAL=16384

L = 128

{ T = 3.0 }

{ T = 2.3 }

{ T = 2.0 }



ParaViewによるスナップショットの可視化
•  paraview

• file ⇒ open ⇒ parm9b.task1.clone1.16384.vtk を選択 ⇒ OK ⇒ Apply


• filters ⇒ common ⇒ glyph (あるいは地球儀のような形のアイコンをクリック)

• Glyph Type = Box, X Length = 0.08, Y Length = 0.08, Maximum Number of 

Points = 20000 ⇒ Apply

• OpenGL window の右上の水平分割アイコンをクリック

• file ⇒ open ⇒ parm9b.task2.clone1.16384.vtk を選択 ⇒ OK ⇒ Apply


• filters ⇒ common ⇒ glyph (あるいは地球儀のような形のアイコンをクリック)

• Glyph を同様に設定


• OpenGL window の右上の水平分割アイコンをクリック

• file ⇒ open ⇒ parm9b.task3.clone1.16384.vtk を選択 ⇒ OK ⇒ Apply


• filters ⇒ common ⇒ glyph (あるいは地球儀のような形のアイコンをクリック)

• Glyph を同様に設定

MateriApps, 2013-2015. All rights reserved.34



ParaView (続き)
• カメラのリンク


• ウインドウのサイズが同じになるように調整


• 真ん中のウインドウをクリック ⇒ Tools ⇒ Add Camera Link ⇒ 左のウインドウ
をクリック


• (あるいは 真ん中のウインドウ右クリック ⇒ Link Camera... を選択 ⇒ 左のウ
インドウをクリック)


• 同様に右のウインドウも左のウィンドウとリンク

MateriApps, 2013-2015. All rights reserved.35



より大規模な系でのスナップショット

MateriApps, 2013-2015. All rights reserved.36

F = E � TS

T=0.995Tc T=Tc T=1.05Tc

エネルギー利得
秩序状態

ordered state

エントロピー利得
無秩序状態

disordered state

臨界点 critical point



二次元XY模型のスピン渦の可視化
• パラメータファイルの変換・シミュレーションの実行・スナップショットの変換


•  parameter2xml parm9c

•  simplemc parm9c.in.xml

•  snap2vtk parm9c.*.snap


• ParaView による可視化


•  paraview

• file ⇒ open ⇒                                                                       

parm9c.task1.clone1.16384.vtk を選択 ⇒ OK


• properties タブ ⇒ Apply


• Glyph を追加


• Glyph Type = Arrow, Tip Radius = 0.2, Shaft Radius = 0.06, Translate = -0.1 0 0, 
Scale = 0.2 0.2 0.2 -> Apply

MateriApps, 2013-2015. All rights reserved.37

LATTICE="square lattice"

J=1

ALGORITHM="xy"

SWEEPS=16384

THERMALIZATION=0

SNAPSHOT_INTERVAL=16384

L = 64

{ T = 0.01 }



二次元三角格子反強磁性ハイゼンベルグ模型
• パラメータファイルの変換・シミュレーションの実行・スナップショットの変換


•  parameter2xml parm9d

•  simplemc parm9d.in.xml

•  snap2vtk parm9d.*.snap


• ParaViewによる可視化

•  paraview

• file ⇒ open ⇒                                                                        

parm9d.task1.clone1.16384.vtkを選択 ⇒  OK


• properties タブ ⇒ Apply


• Glyph を追加し Arrow を設定


• Displayタグ ⇒ Color by ⇒ Glyph Vector ⇒ Z ⇒ Properties タグ


• もう一枚 (parm9d.task2.clone1.16384.vtk) も表示、カメラをリンク

MateriApps, 2013-2015. All rights reserved.38

LATTICE="triangular lattice"

J=-1

ALGORITHM="heisenberg"

SWEEPS=16384

THERMALIZATION=0

SNAPSHOT_INTERVAL=16384

L = 48

T = 0.01

{ H = 0 }

{ H = 5 }



もっと詳しく知りたい人は
• Gromacs のチュートリアル


• http://www.bevanlab.biochem.vt.edu/Pages/Personal/justin/gmx-tutorials/


• MODYLAS web 講習会

• http://ma.cms-initiative.jp/ja/listapps/modylas/modylas_lecture/modylas_weblecture


• ALPS解説記事 (alps-2015.pdf) 

• 藤堂「“実験技術”としての量子多体系シミュレーションソフトウェアALPS」日
本物理学会誌, 70, 275 (2015)


• ALPS web講習会

• http://ma.cms-initiative.jp/ja/listapps/alps/ju6d5o/llgd83


• ALPS Tutorials

• http://alps.comp-phys.org/mediawiki/index.php/ALPS_2_Tutorials:Overview/ja


• 第一原理計算手法によるバンド計算、他

• http://www.slideshare.net/cms_initiative/clipboards/materiappslive

MateriApps, 2013-2015. All rights reserved.39
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MateriApps — 物質科学シミュレーションのポータルサイト
• 公開ソフトウェア(アプリケーション)を核としたコミュニティー形成をめざして

MateriApps,2013-2015. All rights reserved.
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• 155の物質科学アプリケーションや
ツールを紹介(2015年9月現在)


• 「やりたいこと」からアプリケーショ
ンを検索


• 検索タグ：「特徴」「対象」「手法・
アルゴリズム」


• 開発者の声を利用者に届ける

• アプリ紹介、開発者ページ、アプリ
の魅力・将来性・応用性


• フォーラム(掲示板)を利用した意見交換


• 講習会情報・web講習会・更新情報


• 月間 8000 ページビューにまで成長2013年5月公開



MateriApps 掲載アプリケーション
• 155の物質科学アプリケーションやツールを紹介 (2015年9月現在)

MateriApps,2013-2015. All rights reserved.
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密度汎関数法
AkaiKKR☆
OpenMX☆
xTAPP☆
ABINIT☆
...

量子化学
FMO☆
SMASH☆
GAMESS☆
DC☆
...

分子動力学
MODYLAS☆
Gromacs☆
ERmod☆
MDACP
...

格子模型
ALPS☆
DSQSS
BLOCK
DMRG++
...

連続体シミュレーション
ANSYS Multiphysics
Octa ...

データ解析
CLUPAN☆
phonopy☆

可視化
fu☆
TAPIOCA☆

☆ MateriApps LIVE! 収録 ( 一部予定 ) アプリ

(37) (19) (19) (22)

(8) (26) (28)



MateriApps 活動の目的
• 開発者側の問題点


• 有益なプログラムはもっと使われるべきだが、多くのソフトは研究室内にとど
まって終わる


• 公開・情報発信には手間がかかる


• アプリ開発を成果として主張しにくい(指標がない)


• 利用者側の問題点


• どんなプログラムがあるのかよくわからない


• インストール・使い方について知りたい


• 開発者の活動(特に講習会情報)をもっと知りたい


• 両者をつなぐ役割を果たしたい

MateriApps, 2013-2015. All rights reserved.42



アプリケーション普及にむけた三本柱
• アプリの情報発信


• ポータルサイト MateriApps web


• スパコン上でのアプリ利用支援


• 「京」や国内主要スパコンへのアプリのプレインストール MateriApps Installer


• 個人・研究室レベルでのアプリ利用の支援


• MateriApps LIVE!


• インストールや入力ファイルの準備における「壁」を解消


• 計算科学の専門家だけではなく、実験家や企業内の利用、教育活動における活用へ

MateriApps,2013-2015. All rights reserved.
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MateriApps 企画・制作
• 運営:


• 計算物質科学イニシアティブ (CMSI)、東京大学物性研究所 (ISSP)、自然科学研究機構
分子科学研究所 (IMS)、東北大学金属材料研究所 (IMR)


• 計算物質科学イニシアティブ(CMSI) 広報小委員会


• MateriApps 開発チーム

• 藤堂眞治 (東大理/ISSP)、加藤岳生 (ISSP)、五十嵐亮 (CMSI-ISSP)、笠松秀輔 (ISSP)、 
川島直輝 (ISSP)、小西優祐 (CMSI-ISSP)、寺田弥生 (CMSI-IMR)、野田真史 (CMSI-
IMS)、松尾春彦 (RIST)、吉澤香奈子 (RIST)、吉見一慶 (ISSP)


• (委託) 佐々木翔一、土田成宏


• 協力:

• CMSI元素戦略拠点、東京大学物性研究所 計算物質科学研究センター、自然科学研究機
構 分子科学研究所 計算分子科学研究拠点、東北大学金属材料研究所 計算材料科学研究
拠点、高度情報科学技術研究機構
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